


 

A Note from Deputy Commissioner, KVS Delhi Region 
 

 
It is an established fact that the computer education in school plays an 
important role in overall development of students. Computer with an 
internet access is the most powerful weapon, which opens the doorway of 
all information, knowledge and skill available in this universe. However, 
there was a definite syllabus but in the absence of any study material 
transaction of the computer literacy as a subject was limited to the 
imagination of the teacher. 

 

With the advent of new era of artificial intelligence, it is need of the time to 
introduce technology and coding at an early stage to students, in a 
uniformed and standard way. In our endeavour to help students become 
better equipped and confident, we have taken the initiative to develop 
syllabi and textbooks which touch all the paradigm of teaching ICT in well 
directed manner. 

 

This book series for class 3 to 8 has been developed with efforts of many 
teachers and contributions from academicians of KVS Delhi Region. It is 
based on detailed computer literacy syllabus as per CCE(RTE) and all 
applications taught are based on free and open source software. 

 
The lesson is based on interaction between two students from primary 
classes to encourage auto didacticism and to teach them how to think and 
improve problem solving. We have focused on content and skills to lay a 
strong foundation for learning computers. 

 
The accomplishment of this venture depends on the cooperation of all 
principals and teachers who will encourage children, guide them and help 
them at different steps and give them infrastructure and proper guidance 
to use this Book. 

 

Comments on the book and suggestions for next edition are most 
welcome and may be sent to support@kvsrodelhi.in. 

 
 
 
 
 
 

(Nagendra Goyal) 
Deputy Commissioner 
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SYLLABUS 

CLASS 5 

Quarter - APRIL to JUNE 
Sl. 

No. 
Chapters Contents 

1 

Making An 

Impressive 

Presentation 

 1.1 Drawing tools 

 1.2 Master Slides 

 1.3 Working with Slides 

 1.4 Slide Animation 

 1.5 Slide Transition 

2 
Libreoffice 

Calc 
 2.1 

View menu: 

2.1.1   Toolbars 

2.1.2    Formula bar 

2.1.3   Status bar 

2.1.4   View headers 

Quarter - July  to September 

2 
Libreoffice 

Calc (contd.) 

 2.2 

Insert menu: 

2.2.1 Image 

2.2.2 Chart 

2.2.3 Shape 

2.2.4 Function 

2.2.5 Textbox 

2.2.6 Date & Time 

 2.3 

Format Menu: 

2.3.1 Format Text 

2.3.2 Align Text 

3 
More With 

Writer 

 3.1 

Editing the document 

3.1.1 go to a page 

3.1.2 non printing characters 

 3.2 

selecting text  

3.2.1 selecting non-consecutive text 

3.2.2 selecting vertical block 

 3.3 spelling and grammar 
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 3.4 Using synonyms and the thesaurus 

 3.5 Working with tables 

4 
More On 

Internet 

 4.1 WWW (World Wide Web) 

 4.2 Difference between WWW & Internet 

 4.3 Creating Google Account 

 4.4 E-mail  

 4.5 Safe Internet browsing tips 

5 Scratch  5.1 

Clone of the sprite block— “Control” block 

5.1.1 “Create clone of ….” block 

5.1.2 “Delete this clone” block 

5.1.3 “When I start as a clone” block 

Quarter - October to December 

  

 5.2 

  

  

Show and hide block— “Looks” block 

5.2.1 “show” block 

5.2.2 “hide” block 

 5.3 

  

  

  

Receive and Broadcast messages block— 

“Looks” block 

5.3.1 “when I receive…” block 

5.3.2 “broadcast…” block 

5.3.3 “broadcast… and wait” block 

5.4 
Turning the face of the sprite towards 

another sprite— “Motion” block 

5.5. 

Moving the sprite to a particular position—

“Motion” block 

5.5.1 “go to” block 

5.5.2 “go to x… y…” block 

5.5.3 “change x by…” block 

5.5.4 “change y by…” block 

5.5.5 “set x to…” block 

5.5.6 “set y to…” block 

5.6 Pointing the sprite in a direction— 
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“Motion” block 

5.6.1 “point in direction….” Block 

5.6.2 “point towards….” Block 

6 Scratch 

 6.1 

Blocks using keyboard and mouse 

6.1.1 “key... pressed?” — “Sensing” block 

6.1.2 “mouse down?” — “Sensing” block 

6.1.3 “when…. key pressed”— “Events” 

block 

6.1.4 “when this sprite clicked”— “Events” 

block 

6.2 

Create variables and changing their 

values— “Variables” block 

6.2.1 “Make a variable” button  

6.2.2 “set … to…” block 

6.2.3 “change by” block 

6.2.4 “show variable…” block 

6.2.5 “hide variable…” block 

6.2.6 “my variable…” block 

Quarter - January to March  

6 
Scratch 

(Contd.) 

 6.3 “if on edge, bounce”— “Motion” block 

 6.4 Various Operations— “Operators” block 

  
6.3.1 Arithmetic operators— “Operators” 

block 

  
6.3.2 Relational operators— “Operators” 

block 

 
6.3.3 Logical operators— “Operators” 

block 

  6.3.4 More operators— “Operators” block 

Project Projects —in Scratch 
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Teacher then told them about the options in drawing toolbar as labeled below. 

 

Fig 1.2 

1. Select: This Option is used to select anything on the slide just as we 

select by clicking on it with mouse. 

2. Zoom & Pan: This option will help you to Zoom out any object. With Pan 

you can easily see the zoom objects area by moving the screen. 

3. Line Colour: To give colour to boundary lines of selected object. 

4. Fill Colour: To fill the colour in selected 

object. 

5. Line, rectangle, ellipse: To draw these 

shapes. 

6. Arrows & Curves: These options (fig 1.3) provide you 

different types of arrows and curves shapes to draw.     

7. Connectors: Used to connect two objects through glue points. 

   

 

 

 

 

Fig 1.4 

8. Shapes to draw: As available you can draw shapes. 

9. Rotate: To rotate shapes. 

10. Align: Alignments for the shapes. These work same 

as alignments for text we have used in previous class. 

See fig 1.5    

11. Arrange: To arrange a shape in respect to other 

shapes like in back, in front etc. as shown in Fig 1.6 

Fig 1.3 

Fig 1.5 

Fig 1.6 
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Fig 1.17.1    Fig 1.17.2 

Congratulations to ALL. An impressive presentation is ready for slide 

show. 

 

 

 

Let us revise we have learnt: 

 Drawing toolbar can be opened from view->toolbars->drawing. 

 Shape related options are available like inserting shapes, give 3D like, 

Connecting two shapes etc. 

 Master Slides are used to apply themes on the slides. These are also 

known as Master Pages. 

 A Slide can be deleted, Renamed, moved, copied from slides pane. 

 Slide animation are the effects applied over contents of a slide. 

 Slide Transition are the effects of slide advancement. 

 

 

 

 

 

Try Now- Observe the difference between automatic slide movement and 

a movement triggered by mouse click. Which one you find better?  
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EXERCISE 

SOMETHING TO KNOW 

A. Answer the following questions. 

 What is the difference between Slide Animation and Slide Transition?  

 Mahesh has prepared a presentation to present in annual function of 

school. He does not want to click mouse every time to go to next slide. 

Could you help him so that no need of click would be there? 

 Aarti wants to prepare the list of events going to be held in fun fair on 

Diwali. She prepares a slide having title, then two columns For headings 

name of events and duration in minutes. But on one slide only 6 event 

names can be entered. She needs one more slide to write but worried 

that she needs to repeat all settings of first slide in second? Can you 

help her in second slide same as that of first so that she has to do 

least efforts to prepare second slide?  

 What is the purpose of Play button in animation & transition window? 

 Write any two benefits of Master Slides. 

B. Fill in the Blanks. 

i. Crop and Filter option is used over ______ only. 

ii. Default name of slide in a presentation in which already there are six 

slides will be  _______ . 

iii. Through Zoom & Pan we can __________. (Zoom Out/ Zoom in) 

iv. Transitions are exactly same as that you have applied _________ on 

the content of slides 

v. ______ option is used to select anything on the slide. 
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E. State whether following statements are True or False. 

a) Slide transition can also be selected from slide option in menu bar.  

b) Once applied master pages cannot be changed. 

c) Master slides contains themes as of Templates. 

d) Drag & drop is used to change position only of a slide.  

e) Ctrl+X is not applicable over slide. 

SOMETHING TO DO IN LAB 

1) Draw at least five shapes in a slide. Connect them in order using five 

different connectors. 

Try to move objects and observe the connectors.  

2) Insert a new slide and draw an ellipse. Now try direction in ellipse using 

toggle extrusions. 

3) Right click the above slide and make a duplicate slide of it. Insert three 

different curves in such a way that the make a closed figure. Rename 

this slide as “Curve slide”.  
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2. LIBRE OFFICE CALC 

2.1 View Menu  
2.1.1 Toolbars  
2.1.2 Formula bar 
2.1.3 Status Bar  
2.1.4 View Headers  

2.2 Insert menu  
2.2.1 Image  
2.2.2 Chart  
2.2.3 Shape  
2.2.4 Function  
2.2.5 Textbox  
2.2.6 Date and Time  

2.3  Format Menu  
2.3.1 Format Text  
2.3.2 Align Text  

 
Aryan:- Gowri, I was checking out my table we made last year for 

food liked by our friends. Can we do some formatting in it and 

explore it more.  

Gowri :- Yes, Let me tell you about some other menus and different options 

associated with them. Let us work on a table with our classmates and details 

of food items liked by them. Check out the table again. 

 
2.1 View Menu 

The View Menu is the third menu located on menu Bar. It has various options 

associated with it. Each menu has various submenus associated with it. Let me 

tell you about some options as we may not be using all at this stage.  
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     Fig 2.5 

2.2.2 Chart 

Gowri :- Do you know that we can represent data of table in visual form as in 

charts or graphs.  

Aryan :- Yes, Through graphs we can see meaning behind numbers and see 

trends and comparisons easily. It is easier to understand as charts 

communicates information effectively. Please tell me how to do 

it. 

Gowri:- Go to Insert Menu and select the Submenu Chart. In 

the figure given next, you can see that type of chart can be 

selected. Various shapes and 3D look can be selected. The last 

step is to click on Finish button. 
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Fig 2.6 

2.2.3 Shape 

Aryan:- Tell me one thing, can we enter shapes (arrows, callouts, 

square etc.) like we did in writer and impress. 

Gowri:- Yes, we have shape submenu for that in 

Insert menu as shown in the figure given below, 

you can see that various shapes can be inserted . 

The shapes can be lines, basic shapes, block arrows, symbols, stars, banners, 

callouts and flowcharts etc. 
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Fig 2.7 

2.2.4 Function 

Gowri:- There are various functions available to perform 

computation. For example sum function. Go to Insert Menu. 

Select the Submenu 

Function. Insert-> 

Function 

In the figure given below, you can see 

that various functions can be inserted. 

The functions are displayed category 

wise. Alternatively, the function can be 

searched by name.                                                       

                                    Fig 2.8 
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2. Select the Submenu Text 

3. You will see various styles such as Bold, Italic, Underline etc. 

 

Fig 2.11 

Aryan :- I Forgot the shortcuts for these. Can you please remind me again. 

Gowri: - Yes, please.  

Shortcut for Bold  Ctrl + B 

Shortcut for Italics  Ctrl + I 

Shortcut for Single Underline is  Ctrl + U 

Shortcut for Double underline Ctrl + D 

You can also try strikethrough and Overline format also. 

Align Text 

The text can be aligned horizontally or vertically as shown in fig. 2.12. Text 

can be aligned horizontally in four ways. They are: - 

1. Left 

2. Centered 
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3. Right 

4. Justified 

Text can be aligned vertically in three ways. They are: - 

1. Top 

2. Center 

3. Bottom 

Try it out yourself and see the difference. Though you can refer to figure 

2.12 for same. 

 

     Fig 2.12 
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EXERCISE 

SOMETHING TO KNOW 

Q I.  State True or false: 

1. The Bold option is in Insert menu. 

2. The Image option is in Insert menu. 

3. The shortcut for alignment of text to right is Ctrl+R. 

4. The formula bar is in Insert Menu. 

5. Single Underline is in View menu. 

Q II. Match the following:- 

Column A    Column B 

1. Left Align     Ctrl+R 

2. Bold             Ctrl+L 

3. Italic     Ctrl+B 

4. Right Align     Ctrl+; 

5. Insert date    Ctrl+I 

      

Q III. Fill in the blanks:- 

1. The shortcut for inserting time in a spreadsheet is _______________. 

2. The _____________feature is used to strike the text from middle of 

the text. 

3. The shortcut to insert _____________ in a spreadsheet is Ctrl+K. 

4. The shortcut to insert ___________ is Ctrl+F2. 

5. There are  ___________types of vertical alignment in LibreOffice 

Calc. 

QIV. Answer the questions based on creative and critical thinking: - 

1. Aryan wants to make the data bold in the spreadsheet. Which feature 

of LibreOffice Calc is required to do this task? 

2. Gowri wants to underline the names of toppers in a spreadsheet. Which 

feature of LibreOffice Calc will be used by him? 

3. Aryan wants to create a pie chart of data given in a spreadsheet. Which 

feature of LibreOffice Calc will be used by her to create it? 

4. Gowri wants to align the text towards center of the cell in existing 

spreadsheet. Write the shortcut to open it? 

5. Name the menu which has different toolbars present on it. 
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Writer provides you the facility to check the spellings of your words and 

grammar of your sentences.   

Fig 3.5 

 Writer provides a grammar checker. It can be used in combination with 

spell check. 

 Writer gives possible correct suggestions for mistakes saved in its 

dictionary. 

 Automatic spell checker checks each word as it is typed and underlined 

mistakes as in fig 3.4 

 Spelling and grammar option is available in Tools -> Spelling and 

Grammar or click on Spelling and Grammar icon on 

standard toolbar.  (Fig 3.5)  

 A dialogue box appears as in fig 3.6.     

Select the option as 

per your need. 

 

 

 

                                  

Fig 3.6 

Try Now- Type your name and 

observe, is it a correct word in 

Writer or showing as a 

mistake, if yes then try to 

correct it. 

Copyright Number:- L-100561/2021 Registered With:- KVS Delhi Region



P a g e  |  2 6                          KVS DELHI REGION 2021 
 

3.4 USING SYNONYMS AND THESAURUS 

     

 

 

Fig 3.7 shows how to use synonym option. 

Thesaurus shows synonym word list in a 

dialogue box. 

 
Fig 3.7 

 

 

3.5 WORKING WITH TABLES 

  

 

 

 Tables are the best way to store any data in the form of rows 

and columns. 

3.5.1 Create table: Click insert table in table option of menu 

bar. Dialogue box appears as shown in fig 3.8. Choose required number of 

rows, columns, table style and click insert. Table will appeared on the screen 

as shown in (Fig 3.8) 

Try Now- Are you able to find synonym of your name.  

You want to search for 

synonyms. Writer has 

the option for same. 

Select and right click 

on the word as shown 

in fig below. 

Could you please help 

me find words which 

I can use in place of 

Hello. 

I am facing problem in 

creating time table. I 

want to do it in table 

form. 

You can use table 

option of writer 

to make a table. 
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3.5.2 Select Cell / Row / Column: Just click 

cursor in a specified cell or drag mouse over 

required rows or columns to select or use select 

in table option as shown in fig 3.9. 

3.5.2 Insert Row / Column: can insert a column 

or row in a table at any point using insert option 

in table as shown in fig 3.9.    

  

3.5.3 Delete Row / Column: delete option in table menu to delete specified 

row or column as shown in fig 3.9.              Fig 3.8 

 

 

 

 

         

  Fig 3.9                          Fig 3.10 

3.5.4 Size of Row / Column / Cell: use table -> size to set required size as 

shown in fig 3.10. 

3.5.5 Merge Cells: Two or more cells can be merged in to a single cell. Just 

select required number of cells and click table->Merge Cells as shown in fig 

3.11. 

   
        Fig 3.11          Fig 3.12 

3.5.6 Split Cells: To divide a cell in to more than one cell, use table->Split 

Cells. Dialogue box appears as shown in figure 3.12. 

 Try Now- Besides table option in menu bar, observe other places in writer window 

from where you can use table options. 
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4. MORE ON INTERNET 
 

4.1 WWW (World Wide Web) 

4.2 Difference between WWW & Internet 

4.3 Creating Google Account 

4.4 E-mail  

4.5 Safe Internet browsing tips 

 

Aryan: - We have worked so 

much on internet during pandemic 

and learnt a lot in our computer classes. But I came across a 

term “WWW”. Do you know what it means? 

Gowri :-Yes, let me explain about it. 

 

Introduction  

 Today, the Internet is an independent, collaborative and cooperative 

facility accessible for millions of users worldwide. 

 

4.1 World Wide Web   

The World Wide Web (WWW) is a network of web pages found by their 

addresses. It was developed at the European physics lab CERN, home of 

the Hadron Collider, by Sir 

Tim Berners-Lee. The 

development of the webs from 

Berners-Lee’s initial in 1989 to 

the final version with Robert 

Calliou in 1990. 

Fig. 4.1: WWW (World Wide Web) 

4.2 Difference between Internet & WWW 

The Internet is interconnection of network spread over globe. The 

Web is a service that supports it, such as browsers, emails, Online 

Services etc. 
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4.3 Creating Google Account 

Gowri :- Do you have any account on google. I have one. I 

use it for email, drive and many other things. 

Aryan :- No, I don’t have any account, Can you help me 

make an account. I would also like to explore it. 

Gowri :- A Google account lets you log in on computers, 

smartphones and tablets using a single password. By using  

Google account, you can access some of free services  of 

Google. For signing up on google, you should enter some 

information about yourself, like your name, DOB etc. 

Fig. 4.2: Google Services  

Let’s learn how to make a Google Account 

Step 1: Open any Google Webpage  

Step 2: Click the Sign In button and then click 

Create account.  

Internet WWW 

Internet is Massive 

network of networks 

WWW is a way of accessing 

information over Internet 

It does not use web 

browser  

It uses web browser such as 

Chrome, IE etc. 
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Fig. 4.6: Sending an E-mail  

Step 3: A new window will pop up. In ‘to’ text box, type email ID of the 

recipient whom you want to send the mail. 

Step 4:  Write the subject and content of your email in the place 

labeled in Fig 4.6. 

Step 5: If you want to attach a file then do it from attach button 

Step 6: Then click on send button. Your email will be sent. 

You can see the sent e-mails in the Sent folder and draft e-mail (saved 

draft mails) in the Drafts folder. 

Following are the steps to view, read, reply to and delete email message: 

❖ Once log in, make sure you are on the Mail tab on the top left. 

❖ To see your e-mail messages, click on Inbox button. 

❖ To read, click on the message you want to open. 

❖ To reply, click the Reply button at the top of an opened message. 

❖ For reply from the Inbox view, right click a message and click Reply, or 

highlight a message and press R on the keyboard. 
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The following are the safe browsing tips: 

❖ Install antivirus and antimalware 

❖ Creating difficult, varied passwords that are impossible to guess. 

❖ Making all social media accounts private. 

❖ Deactivating auto fill. 

❖ Properly Sign out of all the accounts in place of closing the tab or window. 

❖ Safely open the spam emails and never open or download file from unknown 

sources. 

❖ Safely access public Wi-Fi or hotspots especially free hotspot. 
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EXERCISE 

SOMETHING TO KNOW 

A. Answer the following questions. 

1. What is WWW? Explain it. 

2. What is the difference between WWW & Internet? 

3. Why is it important to create a Google Account? 

4. What is e-mail? 

5. Write some safe Internet browsing tips. 

 

B. Fill in the Blanks 

1. ____________is a Network of Millions of Interconnected Computers. 

2. WWW stands for  _________________________ 

3. _________ provides many online free services like email, YouTube etc. 

4. ____________is used to exchange information over the internet. 

 

C. Match the Following: 

1. WWW a) Google mail 

2. Gmail b) To secure our system 

3. Password c) Electronic mail 

4. Email d) World Wide Web 

D. Select the correct answer for each question : 

1.    ____________ invented the World Wide Web (WWW) in 1989. 

(a)  Sunder Pichai    (b) Tim Berners-Lee  (c) Google   (d) Bill Gates 

 

2. Which of the following is not email providers website 

(a) Google   (b) Microsoft    (c) Yahoo   (d) CBSE 

           

3.  __________ is required to read your email.  

(a) Username & password  (b) mobile no. (c) PAN card (d) house no.  

   

4. Which is not a safe browsing tip? 

(a)  Logout from your email  

(b)  Sharing your password with others 

(c)  Deactivating auto fill 

(d)  Installing Antivirus 
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E. State True  or  False  

1. WWW invented by Larry Page. 

2. Internet is Massive network of networks 

3. Google provides many online services. 

4. We should take precautions when accessing public Wi-Fi or hotspots. 

 

SOMETHING TO DO 
1. Find some educational websites, address name using search engines. 

2. Search some topics of Science by using search engines.  
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5. SCRATCH 
 

5.1. Clone of the sprite block— “Control” block 

5.1.1 “create clone of ….” block 

5.1.2 “delete this clone” block 

5.1.3 “when I start as a clone” block 

5.2. Show and hide block— “Looks” block 

5.2.1 “show” block 

5.2.2 “hide” block 

5.3. Receive and Broadcast messages block— 

“Looks” block 

5.3.1 “when I receive…” block  

5.3.2 “broadcast…” block 

5.3.3 “broadcast… and wait” block 

5.4. Turning the face of the sprite towards 

another sprite— “Motion” block  

5.5. Moving the sprite to a particular position— 

“Motion” block 

5.5.1 “go to” block 

5.5.2 “go to x… y…” block 

5.5.3 “change x by…” block 

5.5.4 “change y by…” block 

5.5.5 “set x to…” block 

5.5.6 “set y to…” block 

5.6. Pointing the sprite in a direction— 

“Motion” block 

5.6.1 “point in direction….” block 

5.6.2 “point towards….” block 

 

Aryan: In the previous class, we had learnt how to code 

using conditions. 

But you still need to teach me how to create clones of the 

sprites in this class. So, could you teach me this now? 

Gowri: Yes dear, today I will definitely teach you that how 

the copies of the sprite can be created and destroyed 

automatically when required.  
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Aryan: OK! I have understood now, I have tried the activity given above, but 

could you please tell me how the sprites are facing towards each other, as all 

the “person” sprites are facing right side in scratch.  

Gowri: Yes, sure dear! It’s very simple and easy. First we will learn turning the 

face of the sprite towards another sprite and later we will learn “goto x and 

y” block. Let’s learn them now. 

 

5.4 Turning the face of the sprite towards another sprite —"Motion” 

block: - 

→ STEP-01 Add the sprite from people tab of “Choose sprite” window. 

→ STEP-02 Place the sprite, where you want. 

→ STEP-03 Then for turning the face of the sprite towards first, click on 

the sprite and then click on Costume tab given below “menu bar”. Choose 

option “flip horizontally” to change the face of the sprite.  

→ STEP-04 Then click on “code” tab to bring the script area back. 

Aryan: Thanks, dear for telling this. but please tell me that what is this “go 

to” block and “point in direction block” used in the coding of game of 

“spaceship” (figure 5.4).  

Gowri: Yes, sure dear! We will definitely learn now what are these “goto” 

block and “point in direction” block. Let’s learn now these following blocks: - 

5.5 Moving the sprite to a particular position— “Motion” block: All 

these blocks are “stack” blocks. 

5.5.1 “go to…” block: -This block has drop down menu, having following 

options: - 

5.5.1.1 “go to random position”: - This block is used to move the 

sprite at random position. It also behaves like “glide” block with 

random position.  

 

Glimpse of show and hide in the story Figure 5.9 
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Now come back to our game project again. 

→ STEP-05 

In the figure 5.4, in “goto…” block “spaceship” 

option is to be chosen to move the sprite 

“missile” to the position of the sprite 

“spaceship”.  Then “point in direction” block is 

used and after that “move 40 steps” block is 

used to move the sprite “missile” till edge of 

the sprite “spaceship”. So that it looks, as 

missile are coming out of the spaceship nozzle. 

→ STEP-06 

Now, choose the sprite “spaceship” and do the 

following code on it (see figure 5.12). First Set 

the position of the sprite “spaceship” at left 

side with position value as -200 and y position 

value as 0 using “goto x… y…” block. Also set the 

size of the spaceship to the 50% of its actual 

size. Now do coding in “forever” block, to move 

the sprite “spaceship” left, right, up and down 

as per key pressed.  If the left arrow key 

press, the sprite will move horizontally in backward direction (left side) by 

the block “change x to -10”. The sprite will move horizontally in forward 

direction (right side) by the block “change x to 10” block. The sprite will move 

vertically in upward direction by the block “change y to 10” block. The sprite 

will move vertically in downward direction by the block “change y to -10” 

block.  

Aryan: OK! I understood now how to move the sprite horizontally and 

vertically and how the missile will move towards the spaceship, when its clone 

appears on the stage. Ok! then what is this “point in direction” block and “key 

pressed?” block.  

Gowri: Aryan, “point in direction” block turns the direction of the sprite 

towards left, right, up, down or towards any other sprite. And “key pressed?” 

block is used to check which key is pressed by us. Lets see “point in direction” 

block first.  
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Exercise 

Something To Know 
A.    Answer the questions given below: 

Q: -1 You have seen so many blocks in the scratch now. Write their names 

to do following tasks. 

Action                                                      Name of Block  

A.  To move the sprite to a random position.  ___________        

B.  To broadcast a message and then wait for 3seconds.                     

         ___________        

C. To turn the sprite towards down side                  ___________        

D.  To move the sprite by 5 more steps vertically.  ___________        

E. To set the position of the sprite to (-100,50) position.  ___________       

F. To check whether the sprite has received any message or not.        

___________ 

Q: -2 Under which block “delete clone of…” block is available in scratch? 

Q: -3 What is the meaning of “set x to…” block? 

Q: -4 What is the meaning of “point towards…” block? 

Q: -5 “show” block is used for _____________. 

Q: -6 Explain “broadcast message” block. 

B.     Fill in the blanks given below: - 

1.     _________________ block, is used to turn the sprite in direction of 

another sprite. 

2. “go to mouse-pointer” block is under __________ block. 

3. ________ block is used to hide the sprite when it is required. 

4. “when I receive…?” block is used for______________. 

5. “when I start as a clone” block is a ____________ block. 

6. ____________ option in “Costumes” tab is used to turn the face of the 

sprite. 

 C.     Write the name of “type of block” for following blocks: 

Name of the block                                  Type of Block 

1.  “when I receive…”                       _____________ 

2.  “go to random position”         _____________ 

3.  “broadcast message”            _____________ 

4.  “when I start as a clone”        _____________ 

         5. “if… then block”                           _____________ 

6. “delete clone of”    _____________ 
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Task to do/something to do 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Create a game of your own choice using different sprites and 

create clone and delete them. 

 Create a project in scratch showing fruits moving here and 

there and creating clone of them and snake is eating them and 

finishing its clone. 
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6. SCRATCH 
6.1. Blocks using keyboard and mouse 

6.1.1 “key… pressed?”— “Sensing” block 

6.1.2 “mouse down?”— “Sensing” block 

6.1.3 “when…key pressed”— “Events” block 

6.1.4 “when this sprite clicked”— “Events” 

block 

6.2. Create variables and changing their values— 

“Variables” block 

6.2.1 “Make a variable” button  

6.2.2 “set … to…” block 

6.2.3 “change by” block 

6.2.4 “show variable…” block 

6.2.5 “hide variable…” block 

6.2.6 “my variable…” block 

6.3. “if on edge, bounce” — “Motion” block 
6.3.1 Arithmetic operators— “Operators” block 

6.3.2 Relational operators— “Operators” block 

6.3.3 Logical operators— “Operators” block 

6.3.4 More operators— “Operators” block 

6.4 Operations— “Operators” block 

 

 

Aryan: In the previous chapter, we have learnt how to create and 

destroy the clone of a sprite, when required. Also, we have learnt 

how to move the sprite to a particular position and turn it in a 

particular direction. So, what are we going to learn today.  

Gowri: Sure dear, today I will definitely tell you about how to use 

keyboard as well as mouse click in our script.  

Aryan: Oh, wow! With the keyboard, we will also learn mouse clicks in our 

script. I am very much excited to learn it now. 

Gowri: Before we start,  please tell me how many arrow keys are available on 

the keyboard.  
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Aryan: I know this dear, there are 4 arrow keys available on the keyboard. 

Left arrow key (←), right arrow key (→), up arrow key (↑) and down arrow key 

(↓). Is it right Gowri?  

Gowri: That’s right! Dear.  So many other keys are also 

available on keyboard like “space key”, all 26 alphabetical keys 

(a to z), 10 numeric keys (0 to 9), Enter key, Ctrl key, function 

keys etc.  

But the keys of the keyboard, on which checking can be done is categorized 

as follows: - 

 “space key”, 2. “alphabetical keys” 3. “numeric keys” 4. left arrow key (←), 5. 

right arrow key (→), 6. up arrow key (↑) 7. down arrow key (↓) 8. any  

Aryan:  What is this “any” key? 

Gowri: If on the keyboard, you want to check that any key is pressed then 

you will choose “any” option.  

Aryan: Which block can used to use the keys of keyboard in our script. 

Gowri: Let me tell you how to use keyboard in our script. We have some 

blocks for this: - 

6.1. Blocks using keyboard and mouse: - The block of instructions which 

uses keyboards and mouse are given below: - 

6.1.1 “key... pressed?”— “Sensing” block: - This block is a “boolean” 

block (which returns output as true or false), which has a dropdown menu. 

You can choose any key from list given in this dropdown list (8 type of 

keys options are available, as discussed above). This block is used to 

check, whether this chosen key is pressed or not. 

6.1.2 “mouse down?”— “Sensing” block: - This block is also a “boolean” 

block. This block is used to check, whether mouse is clicked or not. 

6.1.3 “when…. key pressed”— "Events” block: - This is a “hat” block, 

which has a dropdown menu. You can choose any key from list given in this 

dropdown list. This block is used to execute the specific block of 

instructions written under it, when that chosen key is pressed. 
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6.2.2.1 “my variable”: - This is an already created variable in 

scratch, and can be used anywhere in scratch. 

6.2.2.2 “rename variable”: -This option is used to change the name 

of the variable created by us. 

6.2.2.3 “Delete the…variable”: -This option is used to delete the 

variable created by us. 

6.2.2.4 “Names of variables created by us”: -This option is used 

to change the value of the variable created by us to a specific value. 

E.g. “Set score to 0” will give the value 0 to the “score” variable. 

6.2.3 “change… by…” block: - This block is also a “stack” block, and is 

used to change (increase or decrease) the value of the variable by some 

specific value. E.g., “change score by 1”, will increase the value of this 

variable by 1. 

6.2.4 “show variable…” block: - This block is also a “stack” block, and is 

used to show the variable and its value on the stage, when required. 

6.2.5 “hide variable…” block: - This block is also a “stack” block, and is 

used to hide the variable and its value on the stage, when not required. 

6.2.6 “my variable” block: - This is a “reporter” block and round in 

shape. This block returns the value of “my variable” variable created 

already in scratch. Same like that other blocks are also created for all 

the variables created by us in our scratch project. 

Aryan: What is this “reporter” block now? I have heard to this name for the 

first time in scratch.  

Gowri: Yes dear! These are the blocks, which are designed to fit in the input 

area of other blocks and gives or returns the value of that variable or block.  

Aryan: Ok dear, that’s interesting, now please tell me the script to calculate 

the score of the game and code to decrease the life of the “spaceship” when 

“planet” hits the “spaceship”. 

Gowri: Yes, let’s learn this with the activity given below: - 
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6.3. “if on edge, bounce” block— “Motion” block: - 

  This block is a “stack” block which means the sprite will bounce or jump 

when it touches the edge or boundary of the output stage and sprit can also 

change its direction while jumping. 

 Gowri: Now we will see the “pick random” block, as this block is present in 

“operator” block. There are so many types of blocks present in the 

“Operators” block in the scratch. Let’s discuss them now. 

 

6.4. Various Operations—Operators block: - 

6.4.1 Arithmetic operators— “Operators” block: - There are 4 types of 

arithmetic operators present in “Operators” block. All these blocks are 

“reporter” blocks, means gives or returns some output. 

6.4.1.1 “+” Block: - This block is used to add two values, given on the 

left side and right side of “+” operator. 

6.4.1.2 “-” block: - This block is used to subtract two values, given on 

the left side and right side of “-” operator. 

6.4.1.3 “*” block: - It is used to multiply two values, given on left side 

and right side of “*” operator. 

6.4.1.4 “/” block: - it is used to divide two values, given on the left 

side and right side of “/” operator. 

6.4.2 Relational operators— “Operators” block: - There are 3 types of 

relational operators present in “Operators” block. All these blocks are 

“boolean” blocks, which checks the values gives output in true or false. 

6.4.2.1 “>” block: - This block is used to check whether the left-side 

value is greater than the right-side value or not. 

6.4.2.2 “<” block: - This block is used to check whether the left-side 

value is less than the right-side value or not. 

6.4.2.3 “=” block: - This block is used to check whether the left-side 

value is equal to the right-side value or not. 

6.4.3 Logical operators— “Operators” block: - There are 3 types of 

logical operators present in “Operators” block. All these blocks are 

“boolean” blocks, which gives output in True or False. 

6.4.3.1 “and” block: - This block returns true when the left-side value 

and right-side value of “and” operator, both are true. E.g. pen and 

pencil means both pen and pencil. 
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6.4.3.2 “or” block: - This block returns true when any one of the left-

side value or right-side value of “or” operator, is true. E.g. pen or 

pencil means any one pen or pencil. 

6.4.3.3 “not” block: - This block returns true when the value of the 

variable is false otherwise true.  

6.4.4 More Operators— “Operators” block: - 

6.4.4.1 “pick random… to …: - This block is a “reporter” block and used 

to choose and return any random value from start value to end value. 

6.4.4.2 “join…” block: - This block is a “reporter” block and used to join 

two strings or messages. 

6.4.4.3 “letter … of ….” block: - This block is a “reporter” block and 

used to extract the letter from message given in right side starting 

from the position mentioned in the block by us. 

6.4.4.4 “length of …” block: - This block is a “reporter” block and used 

to find the length of string or message given. 

6.4.4.5 “… contains …?” block: - This block is a “boolean” block and 

used to check whether a letter written on the right-side is contained 

or present in a message or string given on the left-side. 

6.4.4.6 “mod” block: - This block is a “reporter” block and used to find 

the remainder of two numbers by dividing left-side value with right-

side value.  

6.4.4.7 “round” block: - This block is a “reporter” block and used to 

calculate the “round off” value of the number given in the specified 

space. 

6.4.4.8 “abs of …” block: - This block is a “reporter” block and used to 

calculate the absolute value of a number given in the specified space, 

which gives the positive value of a specified number.  

Let’s understand some concepts by activity given below: - 

 

Activity -6.5: Insert the sprite “cat” in scratch and calculate the mod 

of any two numbers. If the result is equal to zero then the sprite “cat” 

plays sound otherwise change the color of the sprite “cat”.  

Ans: → STEP-01 

open the scratch and the sprite “cat” is already present there. 
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B. Fill in the blanks given below: - 

1. _________________ block, is used to add two number values. 

2. “abs of…” block is under __________ block. 

3. ________ block is used to hide the variable when it is not required. 

4. “when this sprite clicked” block is used for______________. 

5. “when I start as a clone” block is a ____________ block. 

6. ____________is the variable, which is already created in scratch. 

 

C. Write the name of “type of block” for following blocks: 

Name of the block    Type of Block 

1. “when this sprite is clicked” _____________ 

2. “my variable”    _____________ 

3. “key pressed?”    _____________ 

4. “… >….”     _____________ 

5. “make a variable”   _____________ 

6. “hide variable…”    _____________ 

7.  “pic random… to…”   _____________ 

 

Something To Do 
 

 

 

 

 

 

 

 

 

 

 

 

1. Create a game of your own choice using different sprites and 

blocks and variables teach till now. 

2. Create a story in the scratch showing different backgrounds 

and music. 

3. Use scratch, and make a project of your own choice. 
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PROJECT IN SCRATCH 

Gowri: As we have learned so many blocks and features of scratch in this 

class and the previous classes as well, Let’s make a project using a bowl and an 

egg. 

Aryan: Oh wow, that’s great.  

Gowri: First, we will understand the game purpose and its rule. See Project 

2.1. 
 

Project 2.1 Add two sprites an “egg” and a “bowl” in your project. Clones 

of a sprite “egg” will be generated in random time from top side of the 

stage and falling in downward direction continuously.  When the sprite 

“egg” touches the sprite “bowl”, bowl collects it and scoreboard is 

increased by 1. You can also move the bowl left or right by Left arrow key 

or right arrow key of the keyboard. But when the sprite “egg” touches the 

edge of the stage, it gets crashed and life of the game is decreased by 

one. When it is repeated 5 times, egg fells down and the game will be over.  

 Gowri:  Let’s discuss its solution now. 

→ STEP-01 

Add three sprites from “choose a sprite” icon as given below: -  

1. Sprite “Bowl” named as “Bowl” and design its new costume (named as 

“bowl-b”) using “Costumes” tab as shown in figure 2.1. this new costume 

is looking like egg is inside the bowl. 

2. Sprite “Egg” named as “Egg” and click on “Costumes” tab and keep its 

costume (named as “egg-b”) and remove all other costumes present in it, 

as shown in figure 2.1. this costume will appear whenever egg is crashed. 

3. Sprite “Penguine2” named as “Gameover” and design its new costume 

(named as “penguin2-b”) using “Costumes” tab as shown in figure 2.1. this 

new costume will be used when game is over. 
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APPENDIX- I 
ANSWERS 

Chapter 1 – Impress 

A. Answer the following questions  

1. Slide Animation is applied over contents of slide whereas Slide transition is 

applied over complete slide. 

2. He can set time in automatic after to move slides. 

3. Duplicate slide or copy slide 

4. It is used to see preview of effects applied. 

5. work as template, save time, can be updated at any time 

 

B. Fill in the Blanks 

i. Images, ii. Slide7, iii. Zoom out , iv. animation, v. Select 

 

C. Match the following 

a) To move a slide  t) Ctrl+X can be used  

b) Connectors connect the 

shapes 

r) through glue points 

c) Line colour gives colour to s) outline of objects 

d) to see zoom screen by 

scrolling  

q) Pan is used 

e) A presentation becomes more 

effective by using 

p) Templates, Master slides 

 

D. Select the right option 

i. d   ii. c   iii.  c   iv.  b   v. b 

E. True/False 

a) True, b) False, c) True, d) False, e) False 

 

Chapter 2 :– Libre office Calc 

1. False  

2.  True 

3. True 

4. False 

5. False 
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II. Left Align-   Ctrl+L 

    Bold-    Ctrl+B 

    Italic-   Ctrl+I 

    Right Align-  Ctrl+R 

    Insert date-  Ctrl+; 

 

III 1. Ctrl+Shift+; 

    2. Strikethrough 

    3.  hyperlink 

     4. function 

     5. three 

 

IV 1. Format-> Text-> Bold (Ctrl+B) 

     2. Format-> Text-> Single Underline 

     3. Insert -> Chart-> Pie 

     4. Ctrl+E 

      5. View Menu 

 

Chapter 3 :– More with writer 

A. Answer the following questions  

1. Synonyms shows the words having the same meaning as of selected text 

where as dictionary shows the words which seems similar to selected text in 

spelling. 

2. Use merge cells options to merge cells horizontally and vertically. 

3. Select all places name using Ctrl key and mouse. Then highlight them in one 

click. 

4. Those characters which are not visible on the screen when pressed from 

keyboard. For example, spacebar 

5. Autocorrect correct the spellings of the words during typing itself. We 

get suggestions instantly using auto correct.  

 

B. Fill in the Blanks 

i. Split cells,   ii. Ctrl,  iii. Alt+Shift+F8  iv. Add to dictionary,  v. 

Edit 
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C. Match the following 

 

a) Randomly selecting text on 

screen 

t) by holding Ctrl key 

simultaneously. 

b) Add to dictionary helps    s) to add a new word 

permanently. 

c) Shift + F7 p) Automatic spell checking  

d) Thesaurus is related to q) Synonym.  

e) to toggle  r) Ctrl+F10 

 

D. Select the right option 

i. b    ii.  c   iii.  d    iv. b     v. d  

E. True/False 

a)False  b)  True  c) True  d) True  e) False 
 
 

Chapter 4:- More on Internet 

A: 

1. Ans.  World Wide Web, which is also known as a Web, is a collection of 

websites or web pages stored in web servers and connected to local 

computers through the internet. These websites contain text pages, 

digital images, audios, videos, etc... 
 

2. Ans.  The Internet is a comprehensive network of computers and was 

conceptualized during 1969 by the ARPA or Advanced Research 

Projects Agency. The World Wide Web is much newer compared to the 

Internet and was initialized during the 1990s. The World Wide Web is a 

collection of web pages following the http protocol that can be accessed 

via the Internet from any part of the world. 

 

3. Ans. A Google account lets you log in on computers, smartphones and 

tablets using a single password. Google synchronises all your data from 

across all your devices, so things like email, photos and documents can 

be accessible wherever you are. 
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4. Ans. Email stands for Electronic Mail. E-mail is defined as the 

transmission of messages on the Internet. 

 

5. Ans. Some of Internet safety browsing tips : 

 Installing antivirus and antimalware 

 Creating difficult, varied passwords that are impossible to 

guess. 

 Making all social media accounts private. 

 Deactivating auto fill. 

B. Fill in the Blanks 

1. Internet 

2. World Wide Web 

3. Google 

4. Email 

 

C. Match the Following. 

1 ---- d 

2 ---- a 

3 ---- b 

4 ---- c 

 

D. Select the correct answer for each question. 

1. B 

2. D 

3. A 

4. B 

E. True  or  False  

1. False 

2. True 

3. True 

4. True 

 

Chapter 5 – Scratch 

Q: -1 You have seen how to create and delete the clone of the sprites in 

scratch. Write the name of block used for following tasks. 

Name of Block 

a. “create clone of…” 
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b. “delete this clone”  

c. “touching…?”  

d. “if..then..” 

Q: -2 Ans: - “Control” block.  

Q: -3 Ans: - This block is a “cap” block (This block ends the script), which is 

used to delete the clone or copy of sprite already created.  

Q: -4 Ans: - This block is a “stack” block, which is used to create the clone 

of the sprite chosen from a list given in this block. This also means creating 

the same copy of the chosen sprite but their scripts are not copied.  

Q: -5 Ans: - “stack” block. 

 

A. Answer the questions given below: 

Q: -1 You have seen so many blocks in the scratch now. Write their names 

to do following tasks. 

Name of Block  

a. “goto random position”  

b. “broadcast… and wait”  

c. “point in direction 1800”  

d. “change y by 5”  

e. “goto x -100 y 50”  

f. “when I receive…?” 

Q: -2 Ans: - “Control” block.  

Q: -3 Ans: - This block is used to change only the x value of the sprite with 

a specific value. It moves the sprite horizontally to particular position. 

Q: -4 Ans: - This is a “stack” block and has a dropdown menu having two 

options: - 

a. “point towards mouse pointer” block:-> This block points the direction of 

the sprite towards mouse pointer. 

b. “point towards sprite-name” block:-> This block points the direction of 

the sprite towards another sprite that we will choose. 

Q: -5 Ans: - This is a “stack” block and it is used to show the sprite, when 

required.  

Q:- 6 Ans: - This block is a “stack” block and it is used to broadcast or send 

the particular message. This block has a dropdown list, from where you can 

choose a message name or can also create a new message and can also set the 

name of message as per your choice. 
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B. Fill in the blanks given below: - 

1. “point towards…” block, is used to turn the sprite in direction of another 

sprite. 

2. “goto mouse-pointer” block is under “Motion” block. 

3. “hide” block is used to hide the sprite when it is required. 

4. “when I receive…?” block is used for doing some specific task when the 

sprite receives the message, sent by same sprite or any other sprite. 

5. “when I start as a clone” block is a “hat” block. 

6. “flip horizontal” option in costume tab is used to turn the face of the 

sprite. 

 

 

C. Write the name of “type of block” for following blocks: 

Name of the block    Type of Block 

1. “when I receive…”    “hat” block 

2. “go to random position”   “stack” block 

3. “broadcast message”   “stack” block  

4. “when I start as a clone”   “hat” block 

5. “if.. then block”    “c-block” block 

6. “delete clone of”    “cap” block  
 

Chapter 6 – Scratch 
 

A. Answer the questions given below: 

Q: -1 You have seen so many blocks in the scratch now. Write their names 

to do the following tasks. 

Name of Block  

a. “mouse down?”  

b. “Change…. by…”  

c. “if on edge, bounce…” 

d. “… > …”  

e. “join…”  

f. “when up key pressed” 

Q: -2 Ans: - “Motion” block 

Q: -3 Ans: - This block is a “stack” block and used to give some value to the 

variable. This block has a drop-down menu, which has 4 options: - 

Copyright Number:- L-100561/2021 Registered With:- KVS Delhi Region



P a g e  |  7 5                          KVS DELHI REGION 2021 
 

a. my variable: - This is an already created variable in scratch, and can 

be used anywhere in scratch. 

b. Rename variable: - This option is used to change the name of the 

variable created by us. 

c. Delete the “…. “variable: - This option is used to delete the variable 

created by us. 

d. Names of variables created by us: - This option is used to change the 

value of the variable created by us to a specific value. E.g. “set score to 

0” block will give the value 0 to “score” variable. 

Q: -4 Ans: - This is a “hat” block, which has a dropdown menu. We can 

choose any key from list given in this dropdown list. This block is used to 

execute the specific block of instructions written under it, when that chosen 

key is pressed. 

Q: -5 Ans: - This block is a “stack” block, and is used to show the variable 

and its value on the stage, when required. 

Q:- 6 Ans: - There are three Logical Operators in “Operators” block. These 

blocks are “boolean” blocks, which gives output in True or False. These are: - 

a. “and” block: - This block returns true when the left-side value and 

right-side value of “and” operator, both are true. E.g. pen and pencil 

means both pen and pencil. 

b. “or” block: - This block returns true when any one of the left-side value 

or right-side value of “or” operator, is true. E.g. pen or pencil means any 

one pen or pencil. 

c. “not” block: - This block returns true when the value of the variable is 

false otherwise true. 

B. Fill in the blanks given below: - 

1. “…. + …” block, is used to add two number values. 

2. “abs of…” block is under “Operators” block. 

3. “hide” block is used to hide the variable when it is not required. 

4. “when this sprite clicked” block is used for checking whether the sprite is 

clicked or not”. 

5. “when I start as a clone” block is a “hat” block. 

6. “my variable” is the variable, which is already created in scratch. 

 

C. Write the name of “type of block” for following blocks: 

Name of the block   Type of Block 

1. “when this sprite is clicked” “hat” block 
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2. “my variable”    “reporter” block 

3. “key pressed?”    “boolean” block 

4. “… >….”     “boolean” block  

5. “make a variable”   “button”  

6. “hide variable…”    “stack” block 

7. “pic random… to…”   “reporter block” 
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